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Abstract

Objective: To report the long-term outcome in terms of safety and efficacy of a new three-dimensional printed
polyethylene (3DP-PE) orbital implant in patients who required orbital reconstruction after eye removal and to measure
area of fibrovascular ingrowth in the orbital implant by using ImageJ software.

Methods: Prospective, consecutive selection in 21 patients which met the criteria. Each case had evisceration,
enucleation, or secondary orbital implant performed by one of three oculoplastic surgeons. A gadolinium-enhanced,
1.5-Tesla MRI scan was performed at least 6 months after surgery. The follow-up time was at least 12 months. Safety
was measured in terms of infection and tissue reaction to the implant. Efficacy was measured in terms of exposure rate,
grades of fibrovascular ingrowth and postoperative results in long-term follow-up. Comparison of vascularisation of
first and second MRI scans was measured by subjective technique and ImageJ software.

Results: The mean age was 40.4 = 15.3 years old (range, 18-73 years old). 57.1% of patients had evisceration
procedures. The mean follow-up time was 64.0 £ 37.4 months (range, 18-128 months). No postoperative infection was
reported. The exposure rate was 19%. A total of four patients had two MRI scans and 75% of patients had increased
enhancement at the second MRI scan, using subjective technique and ImagelJ software. The correlation in interpretation
of enhancement techniques between subjective technique and ImagelJ software was 50%.

Conclusion: A 3DP-PE orbital implant is safe in terms of infection rate in long term follow-up.
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Introduction

The aims of the orbital implant insertion after
enucleation or evisceration are to restore the volume
of the orbit, improve motility and also the external
appearance of the patients. The porous or integrated
orbital implant has become more common since natural
hydroxyapatite orbital implants were introduced in
ocular socket reconstruction. The porous orbital
implant allows vascular and fibrovascular ingrowth
into the implant. This vascularisation promotes
implant motility, decreases migration and extrusion.'
At this time, the materials of porous implants range
from synthetic hydroxyapatite, aluminium oxide and
polyethylene. There are pros and cons among them. The
benefit of polyethylene over synthetic hydroxyapatite
and aluminium oxide is that it is possible to suture
directly to the implant without the need for any
wrapping. However, in our experience, we have found
that the current commercially available polyethylene
(Medpor, Stryker, Kalamazoo, MI, U.S.A.) is not easy
to suture and it also takes time for the implant to uptake
antibiotic solution. Moreover, it is not easy for surgeons
to shape its surface to refit the orbit.

Three-dimensional printing is a manufacturing
technique that has been adopted in many fields of
medicine including to produce orbital implants. We
adopted this technique to fabricate porous orbital
implants by using two-stepped heat treatment process
coupled with large-sized polyethylene powder printing
so the implant has high porosity and large pore size.
The three-dimensional printed polyethylene (3DP-PE)
orbital implant has pore sizes ranging from 140 to
830 um, with porosity of 61.9% which is greater than
those of Medpor. These properties allow the 3DP-PE

implant to be sutured easily and allow the rapid uptake

of antibiotic solution into the implant according to the
report by Suwanprateeb J et al.> A previous study in
animals did not find any infections or adverse systemic
reactions using an onlay bone graft in the mandibles
of New Zealand white rabbits for 24 weeks.? This can
confirm the safety of the 3DP-PE implant in animal
study.

In this study, we prospectively studied the 3DP-PE
orbital implant in a series of patients whose eyeballs
had to be removed in consecutive cases. The study
aimed to evaluate postoperative infection, exposure
rate, to determine the fibrovascular ingrowth in the
3DP-PE orbital implant using MRI of the orbit with
Gadolinium uptake, and also long-term postoperative

results.

Materials and Methods

We recruited all consecutive patients who met
the age and language criteria. Patients who were more
than 18 years old, could co-operate and understand
Thai language were recruited. These patients had
either painless or painful blindness, phthisis bulbi or
needed to reconstruct the orbit to fit new prostheses.
Patients who had prior eye infections up to 6 months
prior to examination, immune suppression, orbital
fracture, orbital radiation, chemotherapy or who could
not be followed-up for at least 12 months post-surgery
were excluded from the study. The operations were
performed by three oculoplastic surgeons (authors
SS, KL, and ML). Data was collected for patients
who had operations between July 2009 and December
2016 and the latest follow-up time was until December
2020. Informed consents were obtained. The study
was approved by the Mettapracharak (Wat Rai Khing)
Hospital Research Ethics Committee (METTA-REC).
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The research adhered to the tenets of the Declaration

of Helsinki.

The three-dimensional printed polyethylene
orbital implant (3DP-PE)

Porous polyethylene orbital implant (Figure
1) was prepared by the technique as described
previously.>* High density polyethylene granules
(Bangkok Polyethylene Co., Ltd, Thailand) were
obtained and ground down to achieve a mean particle
size of 305 mm. Maltodextrin (sourced from Shandong
Dugqing, Inc., China) and poly (vinyl alcohol) (sourced
from Sigma—Aldrich, USA) with a particle size of 80—
100 mm. were mixed with the polyethylene granules
at the ratio of 20:10:70 % by weight. This mixture
was loaded in a three- dimensional printing machine
(7400, Z Corporation, USA) and 16 mm., 18 mm.,
20 mm. and 22 mm. spheres were printed using the
commercial water-based binder ZB7 (Z Corporation,
USA). After fabrication, the specimens were left in the
printing machine for 2 hours, then removed and left in
the atmosphere for 24 hours. The specimens were then

air blown to remove any unbound powder and heat

Figure 1 Three-dimensional printed polyethylene (3DP-PE)

orbital implants

treated by using a wet salt bed technique.*® In brief, the
samples were heated at 145°C for 1 hour, sonicated in
water and heat treated again in a salt powder bed (using
Prungtip salt, Thailand) at 145°C for another 2 hours.
All the samples were then cleaned in deionized water,
dried and packed in a pouch before being sterilised by
ethylene oxide gas. The 3DP-PE orbital implants have
been studied for safety in pigs’ skulls and no signs of
infection were found after implantation for 20 weeks
(Khongkhunthian P., unpublished data 2009) and no
adverse systemic reactions were reported in the New
Zealand study cited above.> Compared to the Medpor
implant,? the 3DP-PE scored well for suturing and

shaping ability and also for antibiotic solution uptake.

Evisceration and Enucleation

Standard eviscerations and enucleations were
performed under general anesthesia. For enucleations,
the surgeons sutured the four recti muscles to the
implants in every case. Posterior sclerotomy or
scleral relaxing incision was applied in some cases of
evisceration. A 3DP-PE implant was soaked and pores
filled with gentamicin (40 mg/ml) solution by negative
pressure technique before insertion. In a case with a
contracted socket, a buccal mucosal graft was harvested
and placed between superior edge of the conjunctiva
after enucleation. A fornix deepening suture was used

1n some cases.

MRI of the orbit

Nine patients were sent to have MRI scans at least
6 months after surgery, of these, five patients underwent
a second MRI scan. Of the remaining patients, some
declined to have MRI scans and others did not attend

their appointments. A whole-body 1.5 Tesla Siemens
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Symphony MRI model (Siemens, Erlangen, Germany)
was used. T1-weighted (TE/TR=680/11) images were
obtained. The imaging sequences had an imaging
matrix of 224 x 320 and a field of view of 160 mm. The
slice thickness was 3 mm. Axial, coronal and sagittal
enhanced T1-weighted images were obtained within 5
minutes of Gadolinium injection. The central part of
the implants and areas of fibrovascular ingrowth were
marked on the image by a technician and verified by
a neuroradiologist. The grades of enhancement of the
fibrovascular ingrowth in the 3DP-PE implants were
classified (by subjective technique) according to the
studies of Klapper SR. et al’ and Galluzzi P. et al®.
The percentage of enhancement in the implants of the
patients who had two MRI scans were also measured

by Image] software (NIH, Bethesda, MD).

Measurement the area of enhancement using

ImageJ software

Image J software for Windows was downloaded
from https://imagej.nih.gov to a personal computer, and
the MRI scan image file of the selected implant was
opened from the File menu. The Freehand selection
tool was used by author (SS) to draw the outline of
the implant. To measure the area of enhancement, the
author (SS) used the thresholding process to highlight
pixels in the image. This was done first by converting
the image to grayscale (choosing Image > type >
8-bit) then by chosing the area within the outline
by using Duplicate command. By using the Image
> Adjust>Threshold tool, the pixels that represent
vascularization turned red. We then adjusted until the
red areas were very similar to the areas of enhancement
in the grayscale photo. We used the Rectangular

selection tool, to limit the area of image analysis. In

the Analyze > Set Measurement tool, we checked the
“Area” and “Limit to Threshold” boxes to measure only
the highlighted pixels within the selected rectangular
area. The “Measure” analytical tool within the software
was used to measure the area in the outline. The author
(SS) used the measurement a total of three times, and
the average of these measurements was calculated
(Figure 2). Lastly, the percentage of enhancement of
the implant was calculated on the basis of dividing the
average area of enhancement by the average total area

of the implant.

[Defautt =] [Rea
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Figure 2 Measurement the area of enhancement using
Image] software. The Freehand selection tool was
used to outline the implant (top left). The author
(SS) adjusted until the red areas were very similar
to the areas of enhancement in the grayscale photo
(top left and right). A rectangular selection was

drawn at the border of the implant (bottom right)
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Statistical analysis

Descriptive statistics were presented using
mean + SD for continuous data and percentage
for nominal data. All statistical data analyses were
performed by SPSS for Windows, version 28.0 (IBM,
Armonk, NY, U.S.A.).

Results

A total of 21 patients met the criteria. The male
patients (52.4%) were slightly predominant. The mean
age was 40.4 = 15.3 years old (range, 18-73 years
old). The left eyes (71.4%) were more prominent. The
primary diagnoses were painful blindness (47.6%),
anophthalmic socket (19.0%), blindness (14.3%),
phthisis bulbi (14.3%), and microphthalmos (4.8%)
respectively. Trauma was the most common cause of
blindness in this study (61.9%). The mean follow-up
time was 64.0 = 37.4 months (range, 18-128 months).

Among types of operation, evisceration was the most

common procedure (57.1%) (Figure 3) and one patient
had secondary orbital implant insertion. The two most
common implant sizes were 18 (47.1%) and 20 mm.
(41.1%). No postoperative infections were found.
The main implant-related complication was implant
exposure (19.0%) (Table 1). The exposed implants
were not sent for culture. Time between operation and
implant exposure was between 1 to 2 months. The
period of follow-up after the last surgery ranged from
61 to 128 months. No further implant exposures were
reported.

Nine patients had an MRI scan of the orbit after
the first operation. The mean period between operation
and first MRI scan was 8.0 = 2.0 months (range, 6.0-
12.0 months). These were assessed by the subjective
technique.”® Accordingly, two (22.2%) patients were
classified as having grade 2 enhancement, five (55.6%)
patients were classified as having grade 3 enhancement

and two (22.2%) patients were classified as having

Figure 3 Preoperative (top), postoperative (middle) photos and the sockets (bottom). (left) The eviscerated patient (at 17

month-follow-up) had levator advancement in right upper lid one year after evisceration. (right) The enucleated

patient (at 30 month-follow-up) had no additional surgeries.
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Table 1 Four patients with exposed implants

Time between

Patient operation

No. Diagnosis Operation Implant and Treatment Follow-up

/sex/side size implant exposure of implant time after

(mm.) (mo.) exposure treatment
(mo.)

1/F/OS Blindness Evisceration 20 2 Enucleation with 97
3DP-PE implant

2/M/OS Phthisis bulbi Evisceration 18 1 Enucleation with 128
3DP-PE implant

3/M/OD Phthisis bulbi Enucleation with 20 1 Dermis fat graft 100

buccal graft
4/M/OS Painful blindness Enucleation 20 2 Dermis fat graft 61

M, male; F, female; OD, right eye; OS, left eye

grade 4 enhancement at first MRI scan (Figure 4).
The mean period between operation and second
MRI scan was 27.0+3.0 months (range, 21.0-30.0
months). Five out of the nine (55.6%) patients had a
second MRI scan. One case was excluded due to poor

image quality from shadow of the prosthesis (Table

Central of implant

2). Of the remaining four cases in this group, using
the above subjective technique, three were assessed to
have increased enhancement in the orbital implant at
the second MRI scan, while the first case was assessed
to have the same enhancement at both first and second

MRI scans. Subsequent measurement by Imagel

Figure 4 Post contrast T1-weighted 1.5 Tesla MRI in evisceration (left) and enucleation (right) patients. Each patient was

tested in axial (top), coronal (middle) and sagittal (bottom) planes. The areas of enhancement were marked by a

technician and verified by a neuroradiologist
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software also showed that three out of four cases in
this group had increased enhancement in the orbital

implant at the second MRI scan, while the fourth case

was assessed to have the same enhancement at both first
and second MRI scans, the two types of measurements

were not correlated in two cases (Table 2).

Table 2 Four patients who had first and second MRI orbit with Gadolinium tests.

Time between surgery and MRI test

(mo.)
Patient Diagnosis Operation 1** MRI 2" MRI

(sex/side) (MRI grade) (MRI grade)
(% of enh.) (% of enh.)

F/OS Painful blindness Evisceration 7 (3) (63.8) 27 (3) (76.5)
F/OS Painful blindness Evisceration 6 (3) (59.7) 21(4) (95.9)
F/OD Anophthalmic socket Enucleation 8(3) (78.8) 28 (4) (91.0)
F/OD Microphthalmos Enucleation with buccal graft 6 (3) (75.0) 27 (4) (74.0)

F, female; OD, right eye; OS, left eye;

MRI, magnetic resonance imaging;

MRI grade, MRI grade by subjective technique;

% of enh, percentage of enhancement measured by ImagelJ software

Discussion

Orbital implant is an important factor in ocular
socket reconstruction whether by enucleation,
evisceration or secondary implant insertion. The first
generation of orbital implants were non-integrated or
non-porous orbital implants. They were made of thin
and light glass, silicone and polymethylmethacrylate
(PMMA), etc. The second generation was the integrated
or porous orbital implant. Natural hydroxyapatite was
introduced as a material for ocular implants in orbital
reconstruction after enucleation and evisceration in
1985 and was approved by the US Food and Drug
Administration for orbital implantation in 1989.° After
that, other medical grade materials such as polyethylene
and aluminium oxide were available. Porous orbital
implants were widely used in many countries!®!’
because porous implants can promote fibrovascular

ingrowth into the implant and improve implant

motility, decrease migration and extrusion.'! Among
the three available materials of porous implant, porous
polyethylene is the only implant that can be sutured
directly on its surface without any wrapping material.
The authors have experienced difficulties in suturing to
the Medpor implant, also in antibiotic solution uptake
and shaping the implant.

We have developed a new porous polyethylene
orbital implant from a three-dimensional printed
technique which has become common for fabricating
many implants in the human body including the orbit.
The three-dimensional printed polyethylene (3DP-PE)
orbital implant was fabricated by a novel two-stepped
heat treatment, coupled with large-sized PE powder
printing to produce porosity and large pore size
ocular implant that facilitates suturing and antibiotic
impregnation.” Suwanprateeb et al® reported that using

a scanning electron microscope (SEM), the 3DP-PE



Sintuwong, et al. Long-Term Outcomes and Measuring Vascularisation of Three-Dimensional Printed Porous Polyethylene 23
Orbital Implant in Enucleation and Evisceration

implant (pore sizes ranging from 140 to 830 wm) had
much greater porosity compared to Medpor (pore size
ranging from180 to 570 wm). According to an earlier
study by Suwanprateeb J et al,? the larger the pore size,
the better the fibrovascular ingrowth. The 3DP-PE
had less density and greater porosity compared to the
Medpor (384.3 vs 494.3 kg/m® and 61.9 vs 48.4%),
hence with the same dimensions, the 3DP-PE is lighter
than the Medpor. It was also found that 1% methylene
blue solution was taken up more rapidly and in greater
quantity by the 3DP-PE than the Medpor2.

Compared to other clinical studies relating to the
Medpor implant, the mean age of patients in our study
was 40.4 = 15.3 years old (range, 18-73 years old),
older than the study of Huang D. et al'®, Tabatabace
et al'” and Naik et al."” There were no postoperative
infections in all cases. This confirms the safety of 3DP-
PE implant. For the efficacy of the 3DP-PE implant, we
studied 21 patients who had operations ranging from
evisceration, enucleation with or without buccal grafts
and secondary orbital implant insertion. For those in
the enucleation group, three patients had enucleation
with buccal grafts and one patient had enucleation with
buccal graft and fornix fixation. Only one patient had
secondary orbital implant insertion. All patients except
two in the evisceration group recovered well after the
operations between 18 and 128 months. Meanwhile all
patients except two in the enucleation group recovered
well after the operations between 23 and 123 months.

The exposure rate in our study was 19.0% with
the mean follow-up time of 64.0 + 37.4 months (range,
18-128 months). Among our three surgeons, two
surgeons had one patient with implant exposure and
one surgeon had two patients with implant exposure.

Among the four patients who experienced implant

exposures (Table 1), two patients had evisceration
operations and two patients had enucleation operations.
For the evisceration group, the time between surgery
and implant exposure was 2 months and 1 month
respectively. The exposed implant of the first patient was
removed and enucleation with a new 3DP-PE implant
was carried out successfully. This patient was followed
up for at least 97 months without postoperative implant
exposure. The second patient had implant exposure one
month after the operation. An enucleation with a new
3DP-PE implant was carried out. This patient (male)
was followed-up for at least 128 months without any
implant exposure. The authors consider that the reason
for the implant exposure in these two eviscerated
cases was because the implants were not placed in the
posterior tenon space properly, because both of them
exposed in the early phase after operations. Currently,
traditional techniques in evisceration surgery have been
replaced in favour of a four-petal technique. For the
enucleation group, two patients experienced implant
exposure at 1 month and 2 months respectively. The
third patient (Table 1) with a history of phthisis bulbi
of unknown causes, had enucleation with buccal graft
(implant size 20 mm.). He had an exposed implant at
one month after the operation. The patient had a small
ocular socket so the surgeon had to harvest a buccal
graft. The authors consider that the cause of early
implant exposure may be the result of high tension on
the anterior surface of the implant. Then the surgeon
decided to remove the implant and harvest dermis fat
for an orbital graft. The patient recovered well for at
least 100 months. The fourth patient (Table 1) was
diagnosed with traumatic painful blindness. He had
implant exposure at two months after operation. The

surgeon removed the implant and harvested dermis fat
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for an orbital graft. The patient recovered well after the
operation for at least 61 months. The authors consider
that the causes of implant exposure in this case might be
from poor vascularisation due to old age and traumatic
in origin.

Karesh et al*’ reported no implant exposure in 21
patients who received enucleation, evisceration and
secondary implant insertion with the mean follow-up
time of 19 months (range, 7-43 months). Naik et al'
compared the fibrovascular ingrowth between Medpor
and Medpor-Plus implants. The exposure rate in their
study was 10% with the mean follow-up time of 36.7
months (range, 18-43 months). Huang et al'® reported
no implant exposure in 21 patients who underwent
modified evisceration techniques. The mean time
between the implantation and MRI scan in this study
was 24.1 = 19.3 months (range, 1.5-69 months). Lin
CW et al*! found that the exposure rate was 76.5% of 17
patients who had Medpor implants and the mean time
to exposure was 73.4 = 51.2 months. The exposure rate
in our study is lower than Lin et al but higher than the
other studies cited above. However, a direct comparison
may not be possible. Our study differs from studies
with a lower exposure rate in two ways. Our study had
longer follow-up times. Secondly, implant exposure
occurred shortly after operation, suggesting surgical
factor rather than implant factor. In our study, three
surgeons were included, with differing experience. Had
the study only included the most experienced surgeon,
the exposure rate would have been less than 19%.

The fibrovascular ingrowth into the implant was
confirmed by MRI of the orbit with Gadolinium uptake.
De Potter P. et al*? reported that areas of enhancement
showed as early as 1.5 months after enucleation. In

this study, the first MRI scans were conducted at

least 6 months after operation because it is assumed
that the implant would have vascularisation within
6 months, and to limit the need for patients to be
subjected to multiple MRI scans. For the results of
the first MRI scan, 77.8% of patients were assessed
to have a gadolinium enhancement of at least grade 3
and more than half of the patients who had second MRI
tests had grade 4 enhancement (Table 2), that is the
fibrovascular ingrowth into the implant increased over
time for at least 28 months. A study by Huang et al'®
found that the mean interval between the evisceration
and the MRI scan was 24.14 = 19.26 months (range,
1.5-69 months)."® He also found that the longer the time
interval between the evisceration and the MRI test,
the greater the increase in the grade of fibrovascular
ingrowth in Medpor. This was also supported by other
studies.?**** Naik et al'” found that the mean area of
vascularisation of the Medpor at 1.5 months, 3 months
and 4.5 months was 58%, 70% and 75% respectively.
The 3DP-PE implant did not differ from other porous
polyethylene implants in terms of fibrovascular
ingrowth. Measurement by Imagel software showed
that three out of four cases who had two MRI scans
had an increase in enhancement in the orbital implant
between the first and second MRI scans. The correlation
in interpretation of enhancement techniques between
subjective technique and ImagelJ software was 50%.
This is the first study to use ImageJ software to measure
area of enhancement in the orbital implant. Further
study with a larger sample size is needed.

This is a case-series study, aimed to determine the
outcomes of the new 3DP-PE orbital implant described
in this study in various eye removal operations and
also the vascularisation into the implant after surgery.

From the results of the study, on the basis of long-



Sintuwong, et al. Long-Term Outcomes and Measuring Vascularisation of Three-Dimensional Printed Porous Polyethylene 25
Orbital Implant in Enucleation and Evisceration

term follow-up, we can be sure about the safety of the
implant. In terms of efficacy, the 3DP-PE implant can
be used successfully in evisceration, enucleation with
or without buccal graft and fornix fixation, and also
in secondary orbital implant insertion. The exposure
rate is acceptable compared to other studies. The
fibrovascular ingrowth of the implant after operation
is also acceptable. Vascularisation may be more
accurately measured using ImagelJ software. The
limited number of patients who had MRI scans in this
study makes it difficult to draw firm conclusions about
the efficacy. Another limitation of the study was that
many surgeons were included in the study, which meant
that it was not possible to control the surgical factors
from different surgeons. In future, a larger study with

a comparison group is needed.
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